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Lab 1 - Learning the MongoDB Lab Environment
MongoDB is an open source document-oriented NoSQL database system written in C++. 
MongoDB stores documents in a JSON-like binary format called BSON that MongoDB 
uses for both data storage and network transfer.  BSON is not a BLOB-like binary as it is 
traversable and, like the regular JSON, supports object and array embedding.

In this lab, we will show how to set up, run, and access an instance of MongoDB on your 
computer.

Part 1 - Understanding the Main Files
The MongoDB system has already been setup for you in the C:\Software\mongodb 
folder.  We will refer to this location as MONGO_HOME.  The system binaries are 
located in the MONGO_HOME\bin folder.  

Note: MongoDB is a self-contained system with no system dependencies.  It is installed 
by unzipping the distribution archive in the directory of your choice.  

The MongoDB database process is launched by a call to the 
MONGO_HOME\bin\mongod.exe file. 

When the process has been properly initialized, you can launch the MongoDB shell 
MONGO_HOME\bin\mongo.exe which, by default, will try to connect to mongod.exe 
on the localhost interface and port 27017.

Part 2 - Creating the Data Folder  
MongoDB requires a data folder to store its database files. By default, on Windows 
platform,  the location for the MongoDB data directory is C:\data\db.  You can use 
another location, but in this case, you need to let MongoDB know where this directory is 
(which is done by passing the location as a --dbpath configuration option, e.g. 
mongod.exe --dbpath c:\projectX\data). 

__1. Open a command prompt window and type in the following command at the prompt 
and press ENTER (execute the command):

dir c:\data\db
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Part 3 - Launching MongoDB
__1. In the command prompt window, execute the following command: 

cd C:\Software\mongodb\bin

This command will change directory to MONGO_HOME\bin where all MongoDB 
binaries are located.

__2. Execute the following command:

title MONGOD

This command will set up the title of the window for ease of reference.

__3. Execute the following command:

mongod --rest

This command will start the MongoDB process and will also activate the RESTful end-
point on the admin web console. 

If you see the Windows Security Alert below then click the Allow access button: 

On successful start up, you should see the following diagnostic messages (last in the 
console output).
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Note: The sequence of the messages may be reverse, depending on which component has 
completed its initialization first.

Port 27017 is used for local process connections (our shell will connect to MongoDB via 
this port), and port 28017 is used to access admin web console using browser.

In subsequent labs, we will be referring to the above steps as Start the MongoDB 
process.

Part 4 - Verifying Access to the Admin Web Console 
__1. Open Google Chrome browser and navigate to http://localhost:28017
The Admin Web Console should open.

The admin console is rather minimalistic in its UI design and provides a view of a variety 
of system parameters. 

Part 5 - Using the MongoDB Shell 
__1. Open another command prompt window and execute the following command at the 
prompt:

cd C:\Software\mongodb\bin

We will use this command window to launch the MongoDB shell to execute commands 
against MongoDB.

__2. Execute the following command:

title MONGO SHELL 
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This command will set up the title of the window as MONGO SHELL.

__3. Execute this command:

mongo 

This command will start the MongoDB shell,  connect to the MongoDB process on port 
27017 and return the command prompt '>'. 

You may see some warnings, for now you can safely ignore them.

Note: You quit the shell by typing the exit command.

By default, you will be connected to the test db.  You can easily create your own 
databases, if needed.

In subsequent labs, we will be referring to the above steps as Start the MongoDB Admin 
shell.

We will explore the MongoDB shell in more detail in one of the subsequent labs.

We are almost done in this lab.

Part 6 - Clean-Up
__1. In the MONGO SHELL window, execute this command:

exit 

This command will stop the current shell session.

__2. Close the MongoDB Shell terminal. 

We will refer to the above steps related to shutting down the MongoDB shell as Shut 
down the MongoDB Admin shell.

__3. In the MONGOD command window, press Ctrl-C (you may need to repeat this 
command again to terminate the process for sure).

This command will flush the database buffers, remove database locks and shutdown the 
MongoDB process.

__4. Close the MONGOD terminal. 

We will refer to the above steps related to shutting down the MongoDB process as Shut 
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down MongoDB.

This is the last step in this lab.

Part 7 - Review
In this lab, we learned about the MongoDB lab environment.
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Lab 2 - The MongoDB Database Operations
Let's quickly review MongoDB data model.

• A Mongo system holds a set of databases   

• A database holds a set of collections (similar to tables in relational databases)

• A collection holds a set of documents (think of them as records in relational 
databases)

• A document consists of a set of fields

• A field is a key-value pair (think of the field as a cell, intersection of a table row 
and a column, where the key is like a column name)

A field key must be a string, and a value can be a number (integer, float), timestamp, a 
JSON document, binary element, and an array of values.  You can also use boolean 
values(true and false), but by default they are interpreted and returned by MongoDB as 
integers (1 for true, 0 for false).

Note that databases and collections of documents are lazily created when the first 
document is saved in them.

Part 1 - The Lab Set-Up
__1. Start the MongoDB process.

__2. Start the MongoDB Admin shell. 

Part 2 - Basic Database Operations
__1. Enter the following command in the MongoDB Admin shell to [tentatively] create a 
new database :

use MyTest

__2. Enter the following command:

db

You should see MyTest printed in the console.
At this point, if you switch back to the test default database, MyTest will be discarded 
since we have not created any content in it.

 Let's start with creating a collection in the current MyTest database with a single JSON 
document containing two fields.
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__3. Type the following command:

db.collection1.save( { key1 : 101, key2 : "string value for key2" } )

Note: You could also have used this statement using the insert() method:

db.collection1.insert( { key1 : 101, key2 : "string value for key2" } )

You should see a confirmation message:

WriteResult({ "nInserted" : 1 })

This command will create and save a JSON document identified between the {} braces 
and passed as a parameter to the save() method into a collection named collection1 in the 
current database (currently, MyTest).  The current database is aliased as db. You don't 
need to put quotes around key names as their conversion to the string type is done 
implicitly by the shell.

The collection collection1, if it does not exist,  will be created on the fly on the first insert 
and named as referenced in the command (collection1).

Fetching data stored in a collection in the current database is done by using the 
overloaded find method.

__4. Type the following command:

 db.collection1.find()

This command will run a full (unfiltered) search of documents in collection1 in the 
current database.  Sample output of this command is shown below.  

{ "_id" : ObjectId("56201255ba984453305e1e5f"), "key1" : 101, "key2" : 
"string value for key2" }

Your output will most likely have a different object id.

Note: Where appropriate, we will substitute "***" for the ObjectId's hash code: 
ObjectId("***").

Upon insertion into a collection, document objects are assigned unique machine-
generated IDs for the predefined _id key which acts as a Primary Key for the collection. 
You can provide your own, more meaningful IDs (it can be a string or a number), as long 
as it is unique in your MongoDB database.  Just add an _id:<ID value> field to the 
document when you create it, e.g. { _id : 'A1', … other fields …}.

The full (unfiltered) find method is similar to the "select * from some_collection" SQL 
statement in relational databases. 
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Using MongoDB's native ObjectId is the preferred way of generating unique values for 
the _id field.  As an added value, MongoDB offers developers a way to extract the 
document's creation time from its ObjectId.  Let's see how you can do this.

__5. Enter the following command:

ObjectId("<Your Object Id>").getTimestamp()
In our case, the command looked as follows: 
ObjectId("56201255ba984453305e1e5f").getTimestamp()   

You should see an instance of the ISO-formatted date printed on the console.

Also, every database maintains a queryable collection named system.indexes that lists all 
the collection indexes.

__6. Enter the following command to get a list of all indexes created in all the collections 
in the current databases:

db.system.indexes.find()

Note 1: When you type commands in the Mongo JavaScript shell, you can get hints on 
objects and methods available in current context by pressing the TAB key twice.

Note 2: The shell supports the buffer of previously typed commands so that you can 
recall and re-use them by using the Up and Down keys.

Note 3: Type help to get quick reference information on objects and their methods. 

Note 4: To get help on available database methods, use the db.help() method on the db 
object.

Note 5: To get help on available collection methods, use the help() method on any 
existing collection in a database: db.someCollection.help()

The unusual thing to those who is new to document-oriented databases is that the 
structure (fields set)  of documents saved in the same collection can be totally different. 

For example, you can now insert another document in the same collection1 but with a 
totally different structure, like this one (the document contains approximate geospatial 
coordinates for area in Toronto, Ontario, around postal code M5G 1Y8 ):

db.collection1.save ({city_name:"Toronto", N:43.6544430, W:79.3871186})

Don't type in the above command!  It is for illustration purposes only!
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This document is not only semantically different from the first one, it has a different 
number and types of fields as well.  MongoDB, however, goes ahead and happily adds it 
to the collection leaving it up to the designer / developer to explain why those documents 
ended up in the same collection.

Note: For all intents and purposes, collections are used for storing homogenous data 
structures (documents in a collection have similar set of fields), but the power of 
MongoDB (and other document-oriented NoSQL databases) lies in its capacity to store 
documents of (totally) different structures.  MongoDB does not impose any specific 
structure constraints that documents must comply with in order to be included in a 
collection.  This schema-less feature (also referred to as "dynamic schema" or "schema 
free") is one of the most useful features of document-oriented databases.  

To put it differently, NoSQL users are not dealing with schema changing commands like 
"alter table add / drop column …" at all, used in relational databases to accommodate 
schema changes requests. 

There is an alternative to the programmatic idiom we used above to save documents in a 
collection by passing the whole document as a parameter to the save method.  You may 
use a more traditional programming practice of assigning the document content to a 
variable first, and then passing the variable to the save method.  Let's see how this is 
done.

__7. Type the following two commands, pressing ENTER after each line:

mybinaries = {one:"1", two:"10", three:"11"}
db.collection1.save (mybinaries)

Here we used a dynamic variable mybinaries to split the assignment operation and the 
saving one. 

The above two commands can also be used in a one-liner command as follows: 

db.collection1.save ({one:"1", two:"10", three:"11"})

If you want to retrieve a document by its primary key (identified by the value in the _id 
field), use the following command:

db.your_collection.find({"_id" : ObjectId("<the object id value>") }) 
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Part 3 - The TTL Feature 
MongoDB offers its TTL (time-to-live) feature for documents to be automatically deleted 
after a configured period of time.  Developers usually use this feature for transient and 
short-lived data, e.g. caches.  The documents to be placed under the expiration control 
should designate a field of the temporal type (date/time) which must be indexed.

__1. Enter the following command:

db.collection1.createIndex ( {"ttl" : 1}, {expireAfterSeconds: 10})

The above command creates an indexed field ttl (it can be named anything else, accepted 
as a JSON key name) that is scheduled to expire in 10 seconds after a document having 
this field is inserted in the collection1 collection. 

All documents that don't have the ttl field, are not subject to the installed expiration 
policy.

__2. Enter the following command:

db.collection1.save ({"ttl" : new Date(), "key2": "another value"})

As you see, we use a Date object (of temporal type) value for the ttl field in this newly 
inserted document.

__3. Enter the following command:

db.collection1.find()

You should see the following output listing the newly added document:

{ "_id" : ObjectId("***"), "key1" : 101, "key2" : "string value for 
key2" }
{ "_id" : ObjectId("***"), "one" : "1", "two" : "10", "three" : "11" }
{ "_id" : ObjectId("***"), "ttl" : ISODate("2015-10-15T22:38:08.924Z"), 
"key2" : "another value" }

After about 10 seconds, repeat the command -- you should see that the newly inserted 
document with the ttl field is gone. If you donèt see the newly ttl document, repeat the 
previous steps quickly.
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Part 4 - Get Collection System Info 
MongoDB exposes methods for querying databases and collections for system 
information.  Let's review some of those methods.

__1. Enter the following command:

db.collection1.stats()

You should see the following output (abridged below for space) representing some 
important metrics of the collection1 collection in the MyTest database.

{
        "ns" : "MyTest.collection1",
        "count" : 2,
        "size" : 224,
        "avgObjSize" : 112,
        "numExtents" : 1,
        "storageSize" : 8192,
...
        "capped" : false,
        "nindexes" : 1,
        "totalIndexSize" : 8176,
        "indexSizes" : {
                "_id_" : 8176
        },
...
}
   

Some of the collection1 metrics are retrievable directly:

db.collection1.count()
db.collection1.storageSize()

Run the above two commands and try to match them with the above system stats.

Use the db.collection1.help()to help on some additional help on getting system 
information.

Part 5 - Programming in the Shell
The MongoDB shell has the capability to execute JavaScript programs, and in this regard 
it resembles development of database-centric applications using such systems as Oracle's 
PL/SQL and Microsoft T-SQL.

Let's see, on a simple example, how you can unleash your JavaScript knowledge to 
generate a bunch of documents in a new collection.
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__1. Enter the following command (you may want to type in the code in your text editor 
and then paste into the Shell window):

function stuffFiller() {
    for (var i = 0; i < 10; i++) {
        db.newCollection.insert(
                {
                    rnd: Math.floor(Math.random() * 100),
                    date: new Date()
                }
        );
        sleep(200);
    }
}

__2. Enter the following command (take advantage of the command auto-completion 
feature on Tab):

stuffFiller()

Wait for the function to complete (for about 10 * 0.200 = 2 seconds).

__3. Enter the following command:

db.newCollection.find()

You should see all the 10 documents inserted in the newCollection collection.

{ "_id" : ObjectId("***"), "rnd" : 57, "date" : ISODate("2015-10-16T15:07:36.702Z") }
{ "_id" : ObjectId("***"), "rnd" : 14, "date" : ISODate("2015-10-16T15:07:36.942Z") }
{ "_id" : ObjectId("***"), "rnd" : 14, "date" : ISODate("2015-10-16T15:07:37.143Z") }
{ "_id" : ObjectId("***"), "rnd" : 8, "date" : ISODate("2015-10-16T15:07:37.344Z") }
{ "_id" : ObjectId("***"), "rnd" : 20, "date" : ISODate("2015-10-16T15:07:37.546Z") }
{ "_id" : ObjectId("***"), "rnd" : 20, "date" : ISODate("2015-10-16T15:07:37.747Z") }
{ "_id" : ObjectId("***"), "rnd" : 41, "date" : ISODate("2015-10-16T15:07:37.948Z") }
{ "_id" : ObjectId("***"), "rnd" : 83, "date" : ISODate("2015-10-16T15:07:38.149Z") }
{ "_id" : ObjectId("***"), "rnd" : 51, "date" : ISODate("2015-10-16T15:07:38.350Z") }
{ "_id" : ObjectId("***"), "rnd" : 60, "date" : ISODate("2015-10-16T15:07:38.553Z") }
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Part 6 - Dropping Collections and Databases 
Let's see how we can drop unneeded collections and databases.

You can always refresh your memory on the related methods by running these 
commands:

db.<any collection>.help()
db.help()

Let's first drop the newCollection collection.

__1. Enter the following command:

db.newCollection.drop()

You should get a confirmation message:

true 

__2. Enter the following command:

db.getCollectionNames()

Quite expectedly, the newCollection collection is gone. 

Note: You could also use the show collections command.

In the MongoDB terminal, you can see the following corresponding information 
message:
… I COMMAND  [conn1] CMD: drop MyTest.newCollection
Now it is time to drop our database.

__3. Enter the following command:

db.dropDatabase()

You should see the confirmation message:

{ "dropped" : "MyTest", "ok" : 1 }
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In the MongoDB terminal, you can see the following corresponding information 
messages:
....I COMMAND  [conn2] dropDatabase MyTest starting
....I JOURNAL  [conn2] journalCleanup...
.......
....I JOURNAL  [conn2] removeJournalFiles
....I COMMAND  [conn2] dropDatabase MyTest finished

__4. Enter the following command:

use test 

__5. Enter the following command:

show dbs 

The MyTest databases is not listed their.

We are almost done in this lab.

Part 7 - Clean-Up
__1. Shut down the MongoDB Admin shell.

__2. Shut down MongoDB.

This is the last step in this lab.

Part 8 - Review
In this lab, we reviewed some of the practical database operations and related commands. 
We also looked at how to get collection's system info and set up the TTL feature.
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Lab 3 - The MongoDB Admin Shell
MongoDB supports a number of clients via appropriate client libraries called "drivers". 
In this lab, we will learn how to use MongoDB's JavaScript-based command-line Admin 
shell that is installed as part of the MongoDB distribution bundle and used for MongoDB 
database administration and development.

Part 1 - The Lab Set-Up
__1. Start the MongoDB process.

__2. Start the MongoDB Admin shell.

Part 2 - Work in the MongoDB Admin Shell 
Mongo developers designed the Admin shell as a DSL (Domain-Specific Language) 
based interactive environment which offers developers and system administrators an 
intuitive and fluent API, where methods are attached to the object in the context of which 
they get executed using the dot ('.') notation. 

As of version in 2.4, mongo uses the V8 JavaScript engine from Google; before, it used 
Mozilla SpiderMonkey.

Note 1: When you type commands in the Mongo Admin shell, you can get hints on 
objects and methods available in current context by pressing the TAB key twice.

Note 2: The shell supports the buffer of previously typed commands so that you can 
recall and re-use them by using the Up and Down keys.

__1. In the MongoDB Admin shell window, enter the following command:

help  

You should see the main help topics printed in the console.

db.help()                    help on db methods
db.mycoll.help()             help on collection methods
sh.help()                    sharding helpers
rs.help()                    replica set helpers
help admin                   administrative help
help connect                 connecting to a db help
help keys                    key shortcuts
help misc                    misc things to know
help mr                      mapreduce

show dbs                     show database names
show collections             show collections in current database
show users                   show users in current database
show profile                 show most recent system.profile entries with time >= 1ms
show logs                    show the accessible logger names
show log [name]              prints out the last segment of log in memory, 'global' is 
default
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use <db_name>                set current database
db.foo.find()                list objects in collection foo
db.foo.find( { a : 1 } )     list objects in foo where a == 1
it                           result of the last line evaluated; use to further iterate
DBQuery.shellBatchSize = x   set default number of items to display on shell
exit                         quit the mongo shell

__2. Enter the following command:

help keys

Read the provided help on using keys in the shell.

Memorize the Emacs-like key combinations for navigating the command line:

Ctrl-A start of line
Ctrl-E end of line
Ctrl-K del to end of line   

You can also add the Ctrl-U combination for deleting text to the left of the cursor and 
Ctrl-R for smart history search.

__3. Enter the following command to get help on available system administration type of 
commands:

help admin 

__4. Enter the following command to get the listing of the files under the c:\software 
folder:

ls ('c:/software') 

__5. Enter the following command to display the currently used database:

db

You should see test (the default database).

Part 3 - Customize the Command Prompt 
Sometimes, you may want to customize the command prompt (showing the '>' character 
by default) with something more dynamic (or creative) and the Admin shell offers you 
this capability with the reserved prompt global variable which is undefined by default.
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__1. Enter the following command:

prompt = function (){ return db + "> ";}

You can also type this command on multiple lines -- the shell will prompt you with a 
triple dot hint (…) until it has enough information to evaluate your input.     

The above command creates a closure that returns the name of the currently used 
database.

Notice, how the shell prompt has now changed from > to test>.

__2. Enter the following command:

use Ether; 

The shell will go ahead to tentatively create a new database called Ether (many shell 
commands are lazily evaluated).

Notice, how the prompt has changed to Ether> 

__3. Enter the following command to change back to the test database:

use test 

__4. Enter the following command:

show dbs

The output does not list the Ether database as we did not give it a chance to materialize 
by creating a collection in it.

Part 4 - Copy / Paste Operations in the Shell
To copy a text in the shell into your clipboard is done by selecting the text you want to 
copy and then press Enter.  Pasting the clipboard's content is done by right-clicking your 
mouse.

Practice the copy/paste operation a couple of times so that you are ready to use this 
technique in subsequent projects.  

Part 5 - Evaluating External JavaScript Files
The Mongo shell supports loading and dynamic evaluation of valid JavaScript commands 
from external files.  Let's demonstrate this important capability.
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__1. Open a new command prompt window and change to the MongoDB home directory:

cd C:\Software\mongodb\bin

__2. Enter the following command:

echo   print ("The current date is :" + new Date())   > toEval.js

__3. Close this command prompt window.

__4. Change to the MongoDB Admin shell window.

__5. Enter the following command to make sure the toEval.js file is indeed in your 
working directory (identified by the pwd() command passed to the ls() admin command):

ls (pwd())

__6. Enter the following command:

load('toEval.js');

You should see the following output (your date and time-stamp will be different),

The current date is :Thu Oct 15 2015 15:44:19 GMT-0400 (Eastern 
Daylight Time)
true

This output comes from the 

print ("The current date is :" + new Date()) 

line of your external script.  

Repeat the command a couple of times observing the time change in the output which 
gets dynamically evaluated each time you run the load command.

We are almost done in this lab.

Part 6 - Clean-Up
__1. Shut down the MongoDB Admin shell.

__2. Shut down MongoDB.

This is the last step in this lab.
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Part 7 - Review
In this lab, we learned about the MongoDB Admin shell: how to get help, customize 
prompt and dynamically evaluate external JavaScript scripts. 
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	Part 2 -  Work in the MongoDB Admin Shell 
	__1.  In the MongoDB Admin shell window, enter the following command:
	__2.  Enter the following command:
	__3.  Enter the following command to get help on available system administration type of commands:
	__4.  Enter the following command to get the listing of the files under the c:\software  folder:
	__5.  Enter the following command to display the currently used database:

	Part 3 -  Customize the Command Prompt 
	__1.  Enter the following command:
	__2.  Enter the following command:
	__3.  Enter the following command to change back to the test database:
	__4.  Enter the following command:

	Part 4 -  Copy / Paste Operations in the Shell
	Part 5 -  Evaluating External JavaScript Files
	__1.  Open a new command prompt window and change to the MongoDB home directory:
	__2.  Enter the following command:
	__3.  Close this command prompt window.
	__4.  Change to the MongoDB Admin shell window.
	__5.  Enter the following command to make sure the toEval.js file is indeed in your working directory (identified by the pwd() command passed to the ls() admin command):
	__6.  Enter the following command:

	Part 6 -  Clean-Up
	__1.  Shut down the MongoDB Admin shell.
	__2.  Shut down MongoDB.

	Part 7 -  Review

	Lab 4 -  Import Export Operations in MongoDB 
	Part 1 -  The Lab Set-Up
	__1.  Start the MongoDB process.
	__2.  Start the MongoDB Admin shell.

	Part 2 -  Understanding MongoDB Number Types
	__1.  Enter the following command:
	__2.  Enter the following code (you can use your editor to enter the commands and then paste the code into the Shell window):
	__3.  Enter the following command:

	Part 3 -  Data Export from MongoDB 
	__1.  Start a new command prompt window and enter the following commands:
	__2.  Enter the following command:
	__3.  Enter the following command:
	__4.  Enter the following command (in one line):
	__5.  Enter the following command (make sure you don't put in a blank between field names: _id,date,num1,num2):

	Part 4 -  Data Import 
	__1.  In the same command prompt window, enter the following command (in one line):
	__2.  Enter the following command (in one line):
	__3.  Close the command prompt window where you performed the export / import operations.
	__4.  Switch to the MongoDB Admin shell window.
	__5.  Enter the following command:
	__6.  Enter the following command:
	__7.  Enter the following command:
	__8.  Enter the following command to back to where we started off:

	Part 5 -  Clean-Up
	__1.  Shut down the MongoDB Admin shell.
	__2.  Shut down MongoDB.

	Part 6 -  Review

	Lab 5 -  Working with Data in MongoDB
	Part 1 -  The Lab Set-Up
	__1.  Start the MongoDB process.
	__2.  Start the MongoDB Admin shell.

	Part 2 -  Querying, Limiting, Sorting and Aggregating data
	__1.  Using the editor of your preference, open the C:\LabFiles\forex.dat file. 
	__2.  Switch to the MongoDB Admin shell window. 
	__3.  At the shell prompt, type in the following command and press ENTER:  
	__4.  Open one more command prompt window and execute the following command at the prompt:
	__5.  In the new command prompt window, execute the following command:
	__6.  Close the current ("mongoimport") command prompt window.
	__7.  Switch back to the MongoDB Admin shell window. 
	__8.  Confirm the import operation with the following command:
	__9.  Execute the following command to retrieve a document (record) for Japan.
	__10.  Execute the following command to retrieve documents (records) for countries with currencies that are cheaper than the US dollar:
	__11.   Execute the following command to count documents (records) in the collection:
	__12.  Execute the following command to filter out and then count documents (records) in the collection:
	__13.  Execute the following command (in one line) to sort exchange rates in ascending order and limit the output to top three documents:
	__14.   Execute the following command to get distinct currency names as a sorted array:

	Part 3 -  Doing Data Aggregation with the group() Method 
	__1.  Execute the following command, pressing ENTER after each line:  

	Part 4 -  Using the MapReduce Operation 
	__1.  Using your editor program, open the  C:\LabFiles\map_reduce_script_MongoDB.txt  file.
	__2.  Copy all the content of the file into the Clipboard. (Ctrl-A, followed by Ctrl-C) 
	__3.  Paste the content of the Clipboard into the MongoDB Admin shell window using mouse's right-click or using the Command Prompt window menu. (Click the window black icon in the top left-hand corner, then in the pop-up menu, select Edit → Paste menu option)
	__4.   To get the user-oriented result of the operation, execute the following command:

	Part 5 -  How to Process Data Using Your Own Programs
	__1.  Enter the following commands (skip the comments prefixed with  '//#'  as those are for your references only ):

	Part 6 -  Updating Data 
	__1.  Enter the following command:
	__2.  Enter the following command:
	__3.  Enter the following command:
	__4.  Enter the following command:
	__5.  Enter the following command:
	__6.  Enter the following command:
	__7.  Enter the following command:

	Part 7 -  Using the Data Aggregation Framework
	__1.  Execute the following command, pressing ENTER after each line:  

	Part 8 -  Clean-Up
	__1.  Shut down the MongoDB Admin shell.
	__2.  Shut down MongoDB.

	Part 9 -  Review

	Lab 6 -  Using MongoDB
	Part 1 -  Run MongoDB
	__1.  Close all open windows and commands prompts.
	__2.  Verify if C:\data\db folder exist, if not then create the folder.
	__3.  Open a command prompt window.
	__4.  Change directory to where MongoDB binary is located. 
	__5.  Start MongoDB server by running:
	__6.  If all goes well you will see the "waiting for connections on port 27017" message.

	Part 2 -  Install mongodb Module
	__1.  Open a new command prompt window.
	__2.  Change directory to C:\LabFiles\biblio.
	__3.  Install mongodb module.

	Part 3 -  Open Database Connection
	__1.  Open  C:\LabFiles\biblio\data_access.js in an editor.
	__2.  Delete the following line. The new implementation will be quite different.
	__3.  At the very top of the file add:
	__4.  Save changes.

	Part 4 -  Implement the findBook Method
	__1.  Delete the body of the findBook method so that it looks like this.
	__2.  Add a callback parameter to the method as shown in bold face below. We will call this callback function after MongoDB returns data.
	__3.   In the body of the method add the lines shown in boldface below.
	__4.  Save changes.

	Part 5 -  Implement the updateBook Method
	__1.  Delete the body of the updateBook method and add the callback parameter as shown in bold face below.
	__2.  Within the body of the method add the lines shown in boldface below.
	__3.  Save changes.

	Part 6 -  Modify the Web Service
	__1.  Open C:\LabFiles\biblio\index.js in an editor.
	__2.  Modify the GET request handler as shown in boldface below.
	__3.  Modify the PUT handler function as shown below.
	__4.  Save changes.

	Part 7 -  Test
	__1.  From a command prompt window change directory C:\LabFiles\biblio.
	__2.  Run your program.
	__3.  From another command prompt window go to C:\LabFiles.
	__4.  Use curl to send a PUT request. We will get the body data from book1.json. The command is broken up in two lines. But should be entered as one line.
	__5.  Verify that status code 200 is returned.
	__6.  Send a GET request to retrieve the book back.
	__7.  Verify that you get the book data back. Note that MongoDB has added a property called _id. This acts as kind of a primary key. By default only this property is indexed by MongoDB. We will learn about indexing later in this lab.
	__8.  Send a request for a non-existent ISBN number and make sure that you get 404 status back.

	Part 8 -  Create an Index
	__1.  Open a command prompt window.
	__2.  Change directory to the bin folder of MongoDB.
	__3.  Run the MongoDB command line client.
	__4.  By default the client connects to the test database. Enter this command to switch to the biblio_db database.
	__5.  Enter this command to do a query and make sure that you can see the document inserted earlier by the web service.
	__6.  Enter this command to get an explanation for the query.
	__7.  The most important property for us is stage. It should be set to COLLSCAN. That indicates that no index is used and the database has to perform full collection scan (go through each item in the collection) to look for the matching documents. 
	__8.  Enter this command to index the isbn property.
	__9.  Now run the explain tool again.
	__10.  Verify that the stage property is now set to IXSCAN indicating that an index scan was performed.
	__11.  Enter Control+D to quit the client tool.

	Part 9 -  Use ES6 Arrow Function
	__1.  Open data_access.js in an editor.
	__2.  In the findBook exported method, locate the callback function supplied to toArray() as shown below.
	__3.  Convert it to an arrow function as shown in bold face below.
	__4.  Save changes.
	__5.  Open index.js.
	__6.  Convert the callback supplied to findBook() as shown in bold face below.
	__7.  Similarly, convert the callback supplied to updateBook().
	__8.  Convert all the route request handler functions to arrow functions also. For example:
	__9.  Save changes.

	Part 10 -  Test
	__1.  End you web service application by hitting Control+C.
	__2.  Run it again.
	__3.  Run this command from C:\LabFiles to verify all is working well.

	Part 11 -  Clean Up
	__1.  Close the command prompt window running MongoDB to stop it.
	__2.  End you web service application by hitting Control+C.
	__3.  Close all windows and editors.

	Part 12 -  Review

	Lab 7 -  CRUD Operations with the MongoDB Java Driver 
	Part 1 -  Setup
	__1.  Start the MongoDB process.
	__2.  Start the MongoDB Admin shell.
	__3.  Using Windows Explorer navigate to:
	C:\Software\eclipse
	__4.  Double click on:
	eclipse.exe
	__5.   When prompted for a workspace enter:
	__6.  Close the Welcome page.
	__7.  Got the File menu and select New → Other. Then select Java Project and click Next.
	__8.  Set the project name to MongoDBCRUD
	__9.  Accept the remaining defaults and click Finish.
	__10.  Click Open Perspective if it's requested to switch of perspective.
	__11.  In the Package Explorer pane right-click on the project you just created (MongoDBCRUD) and select Build Path → Add External Archives.
	__12.  Navigate to C:\Software\mongo-java-driver-3.4.2.jar and click Open.

	Part 2 -  Create the application skeleton
	In this part we will create the application skeleton including the basic code to connect to MongoDB and use a database.
	__1.  In the Package Explorer pane in Eclipse right-click the src folder under MongoDBCRUD.
	
	__2.  Select New → Class from the pop up menu.
	__3.  In the Java Class dialog set the following values (leave all others blank or default).
	__4.  In the Java Class dialog select the checkbox for:
	__5.  Click Finish.
	__6.  Open MongoDBCRUDClient.java in Eclipse. 
	__7.  Declare that the Main method throws Exception (In this lab exercise we are hadling exceptions generically.)
	__8.  Add these two lines of code to the Main method.
	__9.  Go to the Source menu and select Organize Imports. Eclipse will  resolve the imports using the Build Path you configured in Part 1 of this lab. You should now see the imports added and the errors resolved.
	__10.  Save the file.

	Part 3 -  Create 
	__1.  Create a collection by adding the following code after the call to getDatabase() 
		MongoCollection<Document> muscleCars =                                      		db.getCollection("muscle");
	__2.  Next, create a document representing a muscle car.
	Document mustang = new Document()
	     .append("make", "Ford")
	     .append("model","Mustang")
	     .append("year","1967");
	__3.  Repeat step two and create at least three more 'muscle car' documents. Remember each one needs to have a unique Java object name. Use these cars but feel free to add others and be creative!
	__4.  Next Create a List of Documents.
		List<Document> cars = new ArrayList<Document>();
	__5.  Add all the cars to the List (only one shown).
		cars.add(mustang);
	__6.  Add the list to the collection (i.e. add the cars to MongoDB).
		muscleCars.insertMany(cars);
	__7.  Let Eclipse resolve the imports by selecting Organize Imports form the Source menu. You will be prompted for a couple of imports where there are multiple classes with the same name.  Choose the following when given a choice:
	java.util.List	
	org.bson.Document
	__8.  Save the class.
	__9.  Run the application by choosing the Run button in Eclipse.
	__10.  You will see some messages in red in the Eclipse Console.
	__11.  In the MongoDB Admin shell type: 
	__12.  Next, type the following two lines (hit enter between them).
	

	Part 4 -  Read 
	__1.  Comment out all the code in the Main() method except the code required to connect and access the collection as shown below:
	MongoClient mc = new MongoClient();
	MongoDatabase db = mc.getDatabase("cars");
	 
	__2.  Add the following to the imports at the top of the file:
	__3.  Add the find() function with the eq filter set to find all cars with a "make" of "Chevy", call the iterator() function and get a cursor in a try-with-resources block.
	    try( MongoCursor<Document> cursor = 
	          muscleCars.find(eq("make", "Chevy")).iterator() ) {
	    }
	__4.  In the body of the try block, add the code to iterate the cursor and display the car documents as shown in bold.
	    try( MongoCursor<Document> cursor = 
	          muscleCars.find(eq("make", "Chevy")).iterator() ) {
	        while( cursor.hasNext() ) {
	            System.out.println(cursor.next());
	        }
	    }
	__5.  Organize Imports [Ctrl+Shift+O].
	__6.  Save the changes.
	__7.  Run the application by choosing the Run button in Eclipse.
	

	Part 5 -  Update
	__1.  Comment out all the code in the Main() method except the code required to connect and access the collection as shown below:
	MongoClient mc = new MongoClient();
	MongoDatabase db = mc.getDatabase("cars");
	 
	MongoCollection<Document> muscleCars = 
		db.getCollection("muscle");
	__2.  Add the following to the imports at the top of the file:
	__3.  Next add the following code to find the first 1969 Camaro in the collection. This code uses the and filter to make a complex expression.
	__4.  Add the following code to create a new document that has only the new field init.
	Document update = new Document().append("rating", 5);

	__5.  Do the update by adding the following code. We are selecting the _id that matches the previous query and since update only contains the rating field we will add it to the Document without modifying anything else.
	__6.  Organize Imports [Ctrl+Shift+O].
	__7.  Save the changes.
	__8.  Run the application by choosing the Run button in Eclipse.
	__9.  In the MongoDB Admin shell type: db.muscle.find()

	Part 6 -  Delete 
	__1.  Comment out all the code in the Main() method except the code required to connect and access the collection as shown below:
	MongoDatabase db = mc.getDatabase("cars");
	MongoCollection<Document> muscleCars = 
	db.getCollection("muscle");

	__2.  Add the following code to delete all the Chevys in the collection.
	muscleCars.deleteMany(eq("make","Chevy"));
	__3.  Save the class.
	__4.  Run the application by choosing the Run button in Eclipse.
	__5.  In the MongoDB Admin shell type: db.muscle.find()
	__6.  Close eclipse.
	__7.  Close MongoDB and MongoDB Shell.

	Part 7 -  Review

	Lab 8 -  Aggregation with the MongoDB Java Driver 
	Part 1 -  Setup
	__1.  Start the MongoDB process.
	__2.  Start the MongoDB Admin shell.
	__3.  Open a DOS shell. 
	__4.  Change to the mongodb directory:
	__5.  Import the restaurants collection by typing in the DOS shell: (on a single line)
	__6.  Import the reviews collection by typing in the DOS shell: (on a single line)
	__7.  In the MongoDB Admin Shell, type:
	__8.  In the MongoDB Admin Shell, type:
	__9.  In the MongoDB Admin Shell, type:
	__10.  In the MongoDB Admin Shell, type:
	__11.  Verify that the reviews collection loaded.

	Part 2 -  Create the Application Skeleton
	__1.  Start Eclipse in the workspace C:\mongodb-workspace
	__2.  Got the File menu and select New → Java Project.
	__3.  Set the project name to Aggregate
	__4.  Accept the remaining defaults and click Finish.
	__5.  In the Package Explorer pane right-click on the project you just created (Aggregate) and select Build Path → Add External Archives.
	__6.  Navigate to C:\Software\mongo-java-driver-3.4.2.jar and click Open.
	__7.  In the Package Explorer pane in Eclipse right-click the src folder under Aggregate and select New → Class from the pop up menu.
	__8.  In the Java Class dialog set the following values (leave all others blank or default).
	__9.  In the Java Class dialog select the checkbox for: 
	__10.  Click Finish.
	__11.  Open Aggregate.java in Eclipse. 
	__12.  Declare that the Main method throws Exception (In this lab exercise we are handling exceptions generically.)
	__13.  Add this nested class at the top of the main method. This class will be used to echo out the documents we build through aggregation.
	__14.  Add these two lines of code to the Main method.
	__15.  Go to the Source menu and select Organize Imports. If prompt then select org.bson.Document

	Part 3 -  Summary Aggregation 
	__1.  Access the collections by adding the following code after the call to mc.getDatabase("food");
	__2.  Next, add the following code to set up the pipeline. We will be adding stages to the pipeline in the next few steps.
	__3.  Next add the lookup stage inside the call to Arrays.asList() as shown in bold. This function brings data from the other collection into the pipeline: (don't worry about the comma at the end we will be adding more stages.
	__4.  Next add the group stage. This stage counts the number of reviews and calculates the average scores for food and service.
	__5.  Next add the sorting:
	__6.  Organize Imports [Ctrl+Shift+O]
	__7.  Add these static imports after the existing imports at the top of the file. These will give us access to many of the helper functions we will need in this lab:
	__8.  Save the class.
	__9.  Run the application.

	Part 4 -  Detailed Aggregation 
	__1.  After the aggregate function you used in Part 3, add the following code:
	__2.  Next, add the following code to set up the new pipeline. 
	__3.  Next add the lookup stage inside the call to Arrays.asList(). This function brings data from the other collection into the pipeline: 
	__4.  Next, add the match filter to select Katen by name.
	__5.  Next, add the group stage to group by food rating.
	__6.  Finally, add the sort stage.
	__7.  Save the class.
	__8.  Run the application.
	__9.  Close eclipse.
	__10.  Stop and close MongoDB.
	__11.  Exit MongoDB Shell and close all windows.

	Part 5 -  Review 

	Lab 9 -  x509 Authentication in MongoDB  
	Part 1 -  MongoDB 64 bits with SSL
	We will use MongoDB 64 bits with SSL for this lab, in the previous labs you used a no SSL version, SSL only runs in a 64 bits OS.
	__1.  Navigate to C:\Software and double click on this file to run it:
	__2.  Click Run if prompt.
	__3.  Click Next in the Welcome page.
	__4.  Accept the license and click Next.
	__5.  Click Complete.
	__6.  Click Install.
	__7.  Click Yes at any security windows.
	__8.  Click Finish when is completed.
	__9.  Open a command prompt.
	__10.  Change to the MongoDB folder as follows, your installation may was in other folder:
	__11.  Enter the following command to verify the installation was successful.
	__12.  Verify you get the right version.
	__13.  Close all.

	Part 2 -  Set up DNS (hosts file)
	__1.  In the Windows Start Menu navigate to All Programs → Accessories, then right-click on Notepad and select Run as Administrator. 
	__2.  In Notepad open C:\Windows\System32\drivers\etc\hosts
	__3.  Comment all lines.
	__4.  Add the following to the bottom of the file.

	          127.0.0.1	mongodb.was.com
	__5.  Save and close Notepad

	Part 3 -  Examine the CA Certificate
	__1.  Open a DOS Shell to C:\LabFiles\certs
	__2.  Enter the following command:

	Part 4 -  Examine the Server Certificate and Key
	__1.  Make sure you are in a DOS Shell at C:\LabFiles\certs
	__2.  Enter the following command:

	Part 5 -  Examine the Client Certificate and Key
	__1.  Make sure you are in a DOS Shell at C:\LabFiles\certs
	__2.  Enter the following command:

	Part 6 -  Start the Server 
	__1.  Make sure you are in a DOS Shell at C:\LabFiles\certs
	__2.  Enter the following mongod command (all on one line):
	__3.  When prompted (multiple times) for the PEM passphrase enter: p@ssword

	Part 7 -  Connect to the Server 
	__1.  Open a DOS Shell to C:\LabFiles\certs
	__2.  Enter this command:
	__3.  Enable SSL in the client and try again by entering mongo --ssl as follows:
	__4.  Let's add the client certificate the CA certificate and try again. Enter the following command. You will have to enter the PEM passphrase (p@ssword) multiple times when prompted 
	__5.  The final phase is to add the hostname explicitly to the connection information. Enter the following command on one line. You will have to enter the PEM passphrase (p@ssword) multiple times when prompted 
	__6.  Type exit to terminate the command and close the window.
	__7.  In the mongod window press Ctrl+C to terminate the command and close all.

	Part 8 -  Review

	Lab 10 -  MongoDB Authentication  
	Part 1 -  Setup
	__1.  Open a DOS shell and change to the Mongo path:
	__2.  Call this shell as MongoDB:
	__3.  Start MongoDB by typing the following command:
	__4.  Open another DOS shell, call it Mongo and then start Mongo by typing the following commands:

	Part 2 -  Create the admin user
	__1.  The admin user will be created with the following properties:
	__2.  In the Mongo shell connect to admin:
	__3.  Execute this command in the Mongo shell:
	__4.  Verify that the user was created by executing the following command:
	__5.  Shut down mongo in the Mongo shell:
	__6.  Switch to the MongoDB command prompt window.
	__7.  Shut down MongoDB by pressing CTRL+C.

	Part 3 -  Enable Authentication
	One of the challenges with MongoDB is that unlike other databases, security is turned off by default. So not only must you create users, you must also enable authentication. In this part we will start MongoDB with and without authentication enabled then verify the status.
	__1.  Switch to the MongoDB shell and start MongoDB by typing the following command:
	__2.  Switch to the Mongo shell and start Mongo by typing the following command:
	__3.  In the Mongo shell execute the following command:
	__4.  Shut down mongo in the Mongo shell:
	__5.  Switch to the MongoDB command prompt window.
	__6.  Shut down MongoDB by pressing CTRL+C.
	__7.  In the MongoDB shell restart MongoDB by typing the following command:
	__8.  In the Mongo shell restart Mongo shell by typing the following command:
	__9.  In the Mongo shell execute the following command:
	__10.  Pass credentials in the Mongo by executing the following commands:
	__11.  Shut down mongo in the Mongo shell:
	__12.  Connect again:
	__13.  Enter invalid credentials you should see something similar to this:
	
	__14.  Close mongo.
	__15.  Run Mongo again, including credentials, as shown:
	__16.  Run the show dbs command in this Mongo shell. Since we have already been authenticated you will see the databases.

	Part 4 -  Create a Database and a User who can administer it
	__1.  You should still have the the authenticated Mongo shell available.
	__2.  In that shell create a database and insert a value with the following commands:
	__3.  Create a new user with CRUD permissions for the states database with the following command:
	__4.  Switch the user to stateAdmin with the following command:
	__5.  Try again and insert a document:
	
	__6.  Now verify that this user can read the document:
	__7.  Shut down mongo in the Mongo shell:
	__8.  Switch to the MongoDB command prompt window.
	__9.  Shut down MongoDB by pressing CTRL+C.
	__10.  Close all.

	Part 5 -  Review

	Lab 11 -  Project – A RESTful API for MongoDB in NodeJS



